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What is the National Transit Database? 

The National Transit Database (NTD) is the Federal Transit Administration's (FTA's) primary national database for statistics 
on the transit industry. Recipients of FTA’s Urbanized Area Formula Program (Section 5307) and Other Than Urbanized 
Area Formula Program (Section 5311) are required by statute to submit data to the NTD. The legislative requirement for the 
NTD is found in Title 49 U.S.C. 5335(a): 

SECTION 5335. NATIONALTRANSIT DATABASE. 

(a) NATIONAL TRANSIT DATABASE — To help meet the needs of individual public transportation systems, the United 
States Government, State and local governments, and the public for information on which to base public transportation 
service planning, the Secretary of Transportation shall maintain a reporting system, using uniform categories to 
accumulate public transportation financial and operating information and using a uniform system of accounts. The 
reporting and uniform systems shall contain appropriate information to help any level of government make a public 
sector investment decision. The Secretary may request and receive appropriate information from any source. 

(b) REPORTING AND UNIFORM SYSTEMS — The Secretary may award a grant under section 5307 or 5311 only if 
the applicant and any person that will receive benefits directly from the grant, are subject to the reporting and uniform 
systems. 

The Safe, Accountable, Flexible, and Efficient Transportation Equity Act: A Legacy for Users (SAFETEA-LU) amended the 
National Transit Database provisions to establish annual reporting requirements for recipients and beneficiaries for § 5311 
Other Than Urbanized Area formula grants while maintaining existing NTD annual reporting requirements for recipients and 
beneficiaries of Urbanized Area Formula funds. Additionally, Title 49 U.S.C. 5311(b)(4) was amended to provide certain 
specifications of the NTD reporting requirements for Section 5311 grant recipients: 

(4) DATA COLLECTION – Each recipient under this section shall submit an annual report to the Secretary containing 
information on capital investment, operations, and service provided with funds received under this section, including –  

(A) total annual revenue; 

(B) sources of revenue; 

(C) total annual operating costs; 

(D) total annual capital costs; 

(E) fleet size and type, and related facilities; 

(F) revenue vehicle miles; and 

(G) ridership. 

NTD began collecting rural transit data in 2006 using a voluntary model that was developed in consultation with States. The 
2007 reporting system has been updated to reflect the above data requirements. In keeping with the sentiments of the 
States, and the intent of Congress, the NTD offers streamlined and reduced reporting requirements for rural reporting 
relative to the NTD requirements for urbanized area reporting.  

Changes in 2007 Reporting 

 

Exhibit 1 – 2007 Reporting Changes and Highlights 
There are seven changes for the 2007 report year: 
1. Waiver or extension requests are now submitted via the e-File tab. 
2. Additional access levels (Director of Transit Unit and Editor) are now available. 
3. Reporters can add, activate and deactivate subrecipients via the Sys Admin tab. 
4. Beginning in 2007, States should begin providing reports for § 5311 subrecipients who are intercity bus providers. The 

reports for intercity bus providers are substantially reduced from those of other § 5311 subrecipients.  
5. Beginning in 2007, Indian Tribes that receive § 5311 grants directly from the Federal Government (Tribal Transit) must report 

directly to the NTD. States need not provide reports for § 5311 subrecipients that are reporting directly to the NTD. 
6. The Rural General Public Transit Service form (RU-20) has been revised to capture data consistent with SAFETEA-LU 

requirements, more detailed information on funding sources, service data and vehicle fleet characteristics, and additional 
information for Internet Reporting such as URL (web) addresses. 

7. Subrecipients who also receive § 5307 funds and submit NTD Annual Reports do not file RU-20 forms. 
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Who Reports 

States receiving § 5311 funds must report to NTD. For purposes of the NTD, the District of Columbia, Puerto Rico, Virgin 
Islands, American Samoa, Guam, and the Northern Mariana Islands are treated as States (although the District of Columbia 
and the Virgin Islands do not receive any § 5311 grants, and so need not report to the NTD.) The State agency, typically the 
State Department of Transportation administering the FTA Formula Program for Other Than Urbanized Areas (§ 5311) will 
be responsible for collecting and providing data regarding each § 5311 subrecipient in the State serving the general public. 

SAFETEA-LU defines recipients and subrecipients as follows: 
• Recipients are a State or Indian Tribe that receives a § 5311 grant directly from the Federal government 
• Subrecipients are a State or local governmental authority, a nonprofit organization, or an operator of public 

transportation or intercity bus service that receives § 5311 funds indirectly through a recipient. 

Indian Tribes that receive § 5311 grant funds directly from the Federal government (Tribal Transit) must report directly to the 
NTD. 

States do not provide reports on: 
• § 5311 grant subrecipients that are Indian Tribes that are reporting directly to the NTD, nor  
• § 5311 grant subrecipients that are reporting directly to the NTD as an urbanized area reporter. As the reporting 

requirements for an urbanized area are much more extensive than for a rural area, States do not report on behalf of 
these subrecipients.  

What to Report 

Report data for providers of public transportation service in rural areas (other than urbanized areas) of the State. Report data 
for all subrecipients of § 5311 funds. For each subrecipient include all public transportation service provided by the 
subrecipient, regardless of any other funding sources used (e.g. Medicaid, Meals-on-Wheels).  

The NTD rural reporting system consists of three forms that provide State agency or Indian Tribe identification information, 
financial and non-financial operating statistics for individual rural general public transit providers, and a statewide summary. 
These three forms are: 
1. State Agency Identification form (RU-10) 
2. Rural General Public Transit Service form (RU-20) 
3. Statewide Summary –- Rural General Public Transit Service form (RU-30). 

The direct recipient, State or Indian Tribe, completes the State Agency Identification form (RU-10) and completes a Rural 
General Public Transit Service form (RU-20) for each provider of general public transportation service in the other than 
urbanized areas (non-UZAs) of the State. Internet Reporting automatically generates the Statewide Summary form (RU-30) 
from the data reported for individual providers. 

Ideally, the State or Indian Tribe reports data for each provider of general public transportation service in rural areas of the 
State. However, if the there is not complete data from all providers, then report the data that is available. However, 
subrecipients must develop and implement procedures for complete data reporting in 2008.  

Waivers 

There are two waivers for rural reporting: 
1. Report waiver all forms — RU-10, RU-20 and RU-30 
2. Data waiver for a specific data item on an RU-20 form or for a subrecipient’s RU-20 form. 

Request waivers in writing via the e-File tab at least 60 calendar days prior to the report due date. FTA reviews and 
approves these requests on a case-by-case basis. FTA will grant or deny your request in writing via the e-File tab. FTA 
grants waivers for one year only. You must apply for waivers annually. 

Data and Report Waivers 
You may request a waiver of specific data requirements for good cause. In rare instances, you may request a waiver for an 
entire rural report. 

Good cause situations are those that have a continuing impact on the transit agency’s ability to provide service, such as 
floods, earthquakes, or other natural disasters. Good cause situations do not include cost, personnel or data collection 
issues; loss of records; or simply stating undue reporting burden. 

The waiver request must be justified in writing from the chief executive officer (CEO) to FTA. Fully describe the situation that 
prevents the agency from fulfilling the reporting requirements. 
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Example 1 — Accrual Accounting 
Hamlet Transit applies to the state to purchase two buses in fiscal year (FY) 2007 at a projected cost of $440,000, or $220,000 
each. FTA approves the state’s program of projects, which includes the project for Hamlet Transit, and awards FY 2007 Other 
Than Urbanized Formula Program funds based on an 80/20 split for the Federal/non-Federal match. 
Hamlet Transit takes delivery and accepts only one of the buses by the end of FY 2007. 
Solution: Report the Federal share of the bus = $176,000 (1 × $220,000 × 80%) under FTA Other than Urbanized Area funds § 
5311 and the non-Federal share of the bus = $44,000 (1 × $220,000 × 20%) under Local Capital Assistance. 

General Formatting Rules  
Follow these rules when reporting data: 
• Round all financial data to the nearest dollar 
• Report data as whole numbers 
• Use four digits for year entries. 

Mode  
NTD gathers information based on transit mode. Transit agencies operate one or more modes of transit service. A mode is a 
system for carrying transit passengers described by specific right-of-way, technology and operational features.  

The glossary at the end of this manual contains the detailed NTD modal definitions. There is also a discussion of deviated 
bus service, which has characteristics of both bus and demand response modes. 

The NTD Rural reporting system uses the following modes of public transit service: 
Bus (MB)  

 

The most prevalent mode in the 
country, and is powered by a motor and 
fuel contained within the vehicle. 

Demand Response (DR)  

Scheduled in response to calls from 
passengers. Passengers with similar 
origins and destinations are often 
scheduled to ride the same vehicle. Many 
transit systems operate demand 
response (DR) service to meet the 
Federal ADA requirements, and 
expenses and passenger trips are 
reportable for DR. 

Vanpool (VP)  

A commuting service operating under 
pre-arranged schedules for previously 
formed groups of riders in vans. 

4 — Introduction  
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Intercity Bus (IB) 

 
 
Regularly scheduled public service using 
an over-the-road bus that operates with 
limited stops between two urbanized 
areas or connecting rural areas to an 
urbanized area. Intercity bus (IB) mode is 
only used by private, intercity bus 
providers. 

Other  
If none of the choices fits your agency, 
select the category: Other. Internet 
Reporting will display a box for you to 
describe the other mode. 

 

Route-Deviated Service 
Route-deviated service has operating characteristics of both bus (MB) 
and demand response (DR) modes. Route-deviated service operates 
as a conventional bus route, but permits the bus to deviate from the 
route and serve destinations within a prescribed distance (e.g., ¾ 
mile). Report this service as bus mode.  

 
 

 

 
 

Where to Report 

Submit NTD Rural Reports via the Internet at the project’s website, http://www.ntdprogram.gov by clicking on the Internet 
Reporting Login link. 

FTA assigns each state or Indian Tribe an NTD analyst to assist reporters throughout the year. At the beginning of the 
reporting cycle, your analyst will call you to introduce her / himself. Please feel free to contact your analyst if there are any 
questions, or if FTA can do anything to assist you in reporting. 

Introduction — 5 
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Exhibit 3 — NTD Contact Information 
Mailing Address  
You can write to the FTA NTD Project Office at the following 
address: 

Federal Transit Administration 
National Transit Database 
P.O. Box 457 
Merrifield, VA 22116-0457  

Please use the U.S. Postal Service for deliveries to this P.O. 
Box. 

Telephone 
You can contact your NTD analyst and other NTD staff  by 
telephone on weekdays. For telephone information and 
assistance, call the FTA NTD Project Office at: 

703.462.5220 
The FTA NTD Project Office is open from 7:30 am to 5:30 
pm (Eastern Time). If your NTD analyst is unavailable, 
you may use the voice-mail system and your analyst will 
return your call or you may forward your call to another 
NTD analyst. 

Express Delivery Address 
Express deliveries can be made to the following address: 
Federal Transit Administration 

National Transit Database  
3040 Williams Drive, Suite 100 
Fairfax, VA 22031 

E-mail 
You can contact your Rural analyst by using the 
telephone number or e-mail address located on the Home 
tab at: 

www.ntdprogram.gov > Internet Reporting Login 

Fax 
The FTA NTD Project Office also maintains a 24-hour FAX 
service. You may FAX correspondence to the FTA NTD 
Project at: 

703.462.5219 
An original of all faxed documents must also be mailed to 
the FTA NTD Project Office. 

Internet 
Finally, the FTA NTD Project Office manages a website at 
the following address: 

www.ntdprogram.gov 
You mail e-mail comments, questions or suggestions 
directly to the NTD by clicking on the Feedback and Photo 
Gallery link. 
NTD publications, data and reference documents are 
available on the FTA NTD website. 
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Overview 

Transit agencies must use the National Transit Database (NTD) Internet Reporting system to provide their data to the 
Federal Transit Administration (FTA). NTD Internet Reporting is the online means for transit agencies to enter, save, review 
and revise data, and submit reports. It provides for timely and accurate reporting as all tasks and requirements for the NTD 
can be fulfilled via this system. 

This section provides Internet Reporting information for the NTD Rural report. Separate instructions for NTD Annual and 
Safety and Security Internet Reporting are in the Annual Reporting Manual and the Safety and Security Reporting Manual.  

What Has Changed from Prior Year 
Waiver or extension requests are now submitted via the e-File tab. 

Additional access levels (Director of Transit Unit and Editor) are now available. 

Reporters can add, activate and deactivate subrecipients via the Sys Admin tab. 

Detailed financial, vehicle fleet, and service data information has been added to the RU-20. 

Internet Reporting System Security 
FTA implemented numerous measures to ensure that all data entered into the Internet Reporting system are safe and 
available only to those with proper access. A firewall secures the NTD servers and network. The website operates the 
secured web protocol, https, and the entire site is password-protected. Additionally, multiple server and database protection 
layers protect the database files. 

Detailed Instructions 

Accessing the NTD Rural Internet Reporting System 
Access the NTD Rural Internet Reporting System is accessed through the NTD Homepage. 

To access Internet Reporting:  
1. Connect with the Internet via your Internet service provider (ISP) 
2. Access the NTD Project website (www.ntdprogram.gov) 
3. Click on the Internet Reporting Login link 
4. Enter your User Name (Rural identification number) and Password. 

Connecting to the Internet 
Use your Internet service provider to connect to the Internet. NTD Internet Reporting requires the Internet Explorer web 
browser that is at least a 6.0 version. 

If you don’t have the latest version of Internet Explorer, go to Microsoft.com to download the latest version free of charge. 

Verifying Your Internet Browser Settings 
Verify that your browser is set to check for newer versions of stored pages with each visit to the page. 

In Internet Explorer, this is done by accessing Tools / Internet Options / General / Temporary Internet Files Settings / Every 
Visit to Page. 



2007 Rural Report Manual 

The National Transit Database Website 

 
The NTD Home Page offers the following information and data for reporters and others interested in the NTD: 
• Internet Reporting Login link. 
• What is the NTD?: An overview of the NTD program, milestones in transit history, how to obtain an NTD ID number and 

an overview of the NTD reporting forms. 
Reporting Manuals 
• Annual Reporting: Access to .html and .pdf versions of the current Annual Reporting Manual, an overview of reporting 

changes and highlights, reporting manual archives, etc. 
• Monthly Reporting: Access to .html and .pdf versions of the current Monthly Reporting Manual, an overview of the 

reporting changes and highlights, reporting manual archives, etc. 
• Safety and Security Reporting: Access to .html and .pdf versions of the current Safety and Security Reporting Manual, 

Newsletters, Safety and Security FAQs, an overview of reporting changes and highlights, reporting manual archives, 
etc. 

• Rural Reporting: Access to the Rural Reporting Manual, an overview of reporting changes and highlights, reporting 
manual archives, etc. 

Data, Publications and Reference Materials 
• NTD Glossary: HTML version of the NTD Glossary of transit terms. 
• NTD Reference Materials: NTD reference materials such as the Uniform System of Accounts, FTA Circulars and 

Federal Register Notices. 
• Access to NTD Data: HTML and downloadable .pdf publications, including the Data Tables, Profiles, National Transit 

Summaries and Trends, as well as NTD databases and historical data. 
NTD Resources 
• FTA / NTD Presentations, Announcements and Updates: FTA / NTD presentations, new and useful information, 

interim updates to reporting requirements, etc. 
• NTD Feedback: The mailing address, telephone number and fax number for the NTD Project site as well as an 

opportunity to provide comments or suggestions regarding the NTD Program.  
• Seminars and Training: NTD Reporting Seminars and In-house Training information and registration 
• Transit Agency Listing by Region and External Links: Contact information for transit agencies reporting to the 

National Transit Database (NTD). Links to:  
• Federal Transit Administration (FTA) 
• FTA Safety and Security Office 
• U. S. Department of Transportation (USDOT) 
• National Transit Library 
• American Public Transportation Association (APTA) 
• Bureau of Transportation Statistics 
• Accessibility. 

8 — Internet Reporting 
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Accessing the NTD Report  
Clicking the Internet Reporting Login link will open the Internet Reporting Login page. Enter your user name and password 
to gain access to NTD Rural Reporting.  

 

Levels of Access 
Internet Reporting provides three levels of access to the Rural Report:  
1. Director of Transit Unit access: Edit forms (data entry), submit extension requests, and submit report  
2. NTD Contact Person access: Edit forms (data entry) and submit report (administrator)  
3. Editor access: Edit forms (data entry), cannot submit report  

Entering Username and Password 
The user name determines the system access level. The first three characters of the user name define the access level and 
the last four digits represent the transit agency’s NTD ID. There are three types of user names corresponding to the three 
access levels available within the NTD Report: 
1. Director of Transit Unit — DIRxxxx  
2. Contact person — RURxxxx (for Indian Tribes, TRxxxx) 
3. Editor — EDTxxxx 

FTA e-mails each transit agency this set of user names with a password for each. Transit agencies determine access within 
their organizations and distribute user names and passwords accordingly. 
A user can change his / her password at any time. Refer to Sys Admin: Changing Your Password for additional information 
on this topic. Passwords expire every ninety days.  

Internet Reporting — 9 
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NTD Reporting Structure 
NTD Rural Reporting includes the following tabs: 
• Home: The starting point when entering the NTD Rural Report. It displays the reporter’s NTD analyst information and 

any project related announcements. 
• e-File: A listing of all general correspondence and current year report stages. This screen provides a means for a transit 

agency to view the text of existing general correspondence, and to add documents via a file attachment or by 
modification of a pre-existing template. Submit all correspondence and documents to NTD from this screen. 

• Annual: A listing of the forms and provides access to the specific forms necessary to complete the NTD Rural Report. It 
is from this screen that the transit agency submits the NTD Rural Report. 

• Notes: Displays all the Form Notes added to the transit agency’s report. Internet Reporting allows the user to create 
Form Notes to provide additional information applicable to the overall form / report. 

• Issues: Future deployment. Once developed any Issues generated for the report will be accessed from this tab.  
• Reports: Print and export reports. The user can print each form (report) without altering print settings to fit a form on the 

page.  
• Communications: The Communications screen lists a record of the report submissions the agency has made to NTD, 

including any comments from the agency and the review status of the report. 
• Sys Admin: Change NTD passwords — Director of Transit Unit, NTD Contact Person, and Editor. You may only 

change your password. If you need assistance, contact your NTD analyst. The Sys Admin screen is also used to add 
new subrecipients, activate a subrecipient who was deactivated, and deactivate a subrecipient who is no longer 
providing service to the state. 
Managing Subrecipient RU-20 forms is also done via the Sys Admin tab. 

• Help: The Help screen provides a link to an online version of the NTD Rural Reporting Manual and Glossary. 

 

Home: The NTD Rural Report Home Page 
Go to the Home Tab to access the NTD Rural Reporting System. To return to the Home tab view from any other area click 
the Home tab near the top of any screen. 

10 — Internet Reporting 
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e-File: Communicating with FTA 
The e-File screen displays the status of your report and any correspondence between your agency and the NTD including 
waivers and filing extensions. Click on the e-File tab to open the e-File screen.  

Report Stage 
The NTD Rural Reporting System incorporates several stages of report status: 
• Working Data: The state agency is able to enter and edit data only when the report is in Working Data status. Prior to 

submission, the report is in Working Data status.  
• Original Submission: After completing and saving each form, the state agency submits the report to FTA by clicking on 

the Submit button on the Annual tab view. Once the state agency submits the report, the report is in Original 
Submission status. The state agency or FTA may review the data review at any time. The state agency cannot alter any 
data in Original Submission status. 

• Submission Revision: After review of the submission by the analyst, the report is available in Working Data status 
again for further revision by the reporting state agency. After revising and saving forms in Working Data status, the state 
agency submits a revised report to FTA by clicking on the Submit button on the Annual tab view. The data is then 
frozen in sequentially numbered Submission Revision status. 

• Closeout: Closeout status is the final report status. 
 

 

Forms: Providing Data to the NTD 
Click on the Annual tab to open the Forms Summary screen.  

The Forms Summary screen provides links to the forms your agency will complete for NTD Rural Reporting.  

Initially, the Forms Summary screen provides access to the State Agency Identification form (RU-10). The State Summary 
form (RU-30) and Add Form button will be viewable after submitting the RU-10. The Forms Summary screen allows the 
State agency to add a Rural General Public Transit Service form (RU-20) after a new subrecipient is added and assigned a 

Internet Reporting — 11 
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subrecipient identification number via the Sys Admin tab. To add an RU-20, click on the Add Form button at the bottom of 
the screen. The list of added subrecipients will appear; select the new subrecipient from the Drop-Down menu. The new 
subrecipient RU-20 form will appear on the Forms Summary screen highlighted in yellow.   

All form-by-form instructions and reporting details are in the form specific sections of this manual. The Forms Summary 
screen provides access to the required forms for your transit agency. For each form, the Forms Summary screen identifies 
the update user and update date.  

Submitting Your Report 
To submit your report to the NTD, upon completing the required NTD Rural forms and reviewing and saving the RU-30, 
return to the Annual tab, scroll to the bottom of the page and click the Submit Report button. 

 

Notes: Providing Additional Information 
Click on the Notes tab to open the Notes Summary screen. The NTD Rural Reporting System allows the state agency 
reporter to create form notes for additional information applicable to the overall form. 

Creating a Form Note 
To create a form note click on the Add Form Note link at the top right of the form you are editing or viewing. Internet 
Reporting will take you to the Form Notes screen for the specific form. Internet Reporting will pre-fill the form type and 
recipient (if applicable) for which the note is created. The transit agency completes the note comment. 

To save a form note, click on the Save button at the bottom of the screen. To return to the form being edited without saving 
the note, click on the Cancel button. 

Reviewing Notes 
Click on the Notes tab to view the Notes Summary screen. You can review the notes associated with a specific form or all 
notes for the report. While working in a form, click on the Notes tab to access the Notes screen for the form. Internet 
Reporting displays the form name just beneath the tabs. 

Editing Notes 
You can edit Notes only in the Working Data stage. Click on the Edit Note link in the far right column on the Notes screen. 
Once the state agency submits the NTD Rural Report, Internet Reporting prevents any editing of the notes.  

Printing Form Notes 
Form notes are printed as part of each form’s report that is generated using the Print button at the bottom of each form. 

 

Reports: Viewing, Printing, and Exporting Reports to Assist in Preparing the NTD Report  
Click on the Reports tab to display the Reports screen. This screen provides access to the Revenue Vehicle Inventory 
Report, generated off of the combined RU-20 vehicle data, and is available to assist you in preparing your NTD report. 

12 — Internet Reporting 
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To open a report click the corresponding link on the Reports screen. 

All Form Notes Report 
Click on the All Form Notes Report link to print all of the form notes associated with the NTD Rural report viewed on the 
Form Notes screen. 

Printing a Form Report from a Form Screen 
Click on the Print button at the bottom of the form screen to display the report in Adobe Acrobat Viewer. Click the Print 
button in the upper left corner of the viewer. Then click the Okay button on the resulting Print window. 

 

Communications Summary: Viewing a History of Correspondence with NTD 
The Communications tab gives transit agencies a centralized area in which to view past correspondence with the NTD 
program. Transit agencies can view correspondence by communication types. 

 

Sys Admin Tab: Changing Passwords, Adding or Deactivating Subrecipients 
The Sys Admin screen provides the ability to change your NTD password, as well as add, activate and deactivate a 
subrecipient. 

Changing Your NTD Password 
FTA assigns each NTD user a unique temporary password. With the launch of the 2007 Reporting software, you may login 
to NTD Reporting one time using this assigned password. Internet Reporting will prompt you to change your password at 
that time. Users can change passwords at any time by clicking on the Sys Admin tab. Follow the instructions for creating 
new passwords: 
• Passwords are a minimum of eight characters and be a combination of upper and lower case letters and numbers. Do 

not use dictionary words. 
• Change passwords at least every 90 days. Do not repeat passwords. NTD will change any compromised passwords 

immediately.  

Internet Reporting — 13 
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Adding a Subrecipient 
To add a new Subrecipient that was not reported in the previous year’s report, click on the Add Subrecipient link on the Sys 
Admin tab. On the Add Subrecipient screen, enter the Subrecipient name on line 01, select the type of recipient (Tribal or 
non-Tribal) and click Save to create new subrecipient ID. You will be taken back to the Forms Summary screen. Click the 
Add Form button to generate a Rural General Public Transit Service form (RU-20) and select the new subrecipient ID from 
the drop-down. Click the Generate Form button and the new subrecipient’s RU-20 form will appear highlighted in yellow. 

 

Activating a Subrecipient 
To activate a Subrecipient that did not report in the previous year’s report but will be included in the current year’s report, 
click on the Activate Subrecipient link on the Sys Admin tab. On the Activate Subrecipient screen, select the 
subrecipient’s name from the drop-down and click Update to activate the Subrecipient ID. Click the Save button, and you will 
be taken back to the Forms Summary screen. Click the Add Form button to generate a Rural General Public Transit 
Service form (RU-20) and select the activated subrecipient ID from the drop-down. Click the Generate Form button and the 
activated subrecipient’s RU-20 form will appear highlighted in yellow. 

 

Deactivating a Subrecipient 
To deactivate a Subrecipient who reported in the previous year’s report but will not be included in the current year’s report, 
click on the Deactivate Subrecipient link on the Sys Admin tab. On the Deactivate Subrecipient screen, select the 
Subrecipient name from the drop-down on line 01 and click Update to deactivate them. If a Rural General Public Transit 
Service form (RU-20) was created and data entered for the subrecipient, it will be deleted and all data will be lost when the 
subrecipient is deactivated. This data cannot be activated or retrieved once it has been lost. 
Note: To reactivate a Subrecipient who was previously deactivated, or deactivated in error, do not use the Subrecipient 
Management Tool. Contact your Analyst to reactivate a Subrecipient. 
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Help: Obtaining More Information 
Click on the Help tab to open the Help screen. The Help screen provides access to the 2007 Rural Reporting Manual for 
additional help in completing the appropriate forms. The Help screen displays the table of contents for the Rural Reporting 
Manual with links to each section of the manual. 

Tips for Using Internet Reporting 

Navigating Between Screens 
Do not use the browser Back and Forward buttons to navigate between screens. Instead, use the Internet Reporting system 
buttons, tabs and links.  

Saving a Form 
Use the Save button provided at the bottom of each form. When entering information into a form we strongly recommend 
that you save the form frequently. This will prevent the loss of data if your Internet connection is unexpectedly lost. Also, 
Internet Reporting has an automatic time-out feature which will log you off of the system after a period of inactivity. We 
strongly recommend that you save your work every 15 minutes. Otherwise, there is a risk that the next action you take on the 
system will result in the closure of the screen displayed in your browser and the loss of any data that you had not saved. 

Printing 
For trouble-shooting information refer to the Announcement section of the Home tab. 

Downloading the Adobe Acrobat Viewer for Forms 
In order to facilitate viewing and printing forms Internet Reporting utilizes the Adobe Acrobat downloadable viewer. Internet 
Reporting will prompt you to download the Adobe Acrobat Viewer free of charge the first time you try to print a report. Click 
the Print button on a form page to download the Adobe Acrobat Viewer. This download occurs only once and is absolutely 
necessary to view or print a report. 

To Print a Form Report from a Form Screen 
Click on the Print button at the bottom of the form screen to display the report in the Adobe Acrobat Viewer. Click the Print 
button  in the upper left corner of the viewer. Then click the Okay button on the resulting Print window. 
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State Agency Identification form (RU-10) — 17 

This module contains three forms: 
1. State Agency Identification form (RU-10) 
2. Rural General Public Transit form (RU-20) 
3. Statewide Summary form (RU-30) 

State Agency Identification form (RU-10)  

The State Agency Identification form (RU-10) collects contact information for the reporting State agency or Indian Tribe. The 
form includes agency identification information, transit unit director information, and NTD contact person information. Internet 
Reporting pre-fills for 2007 the report year 2006 form information. Update any information that has changed. Saving this form 
will generate your option to add forms Rural General Public Transit Service form (RU-20) and the Statewide Summary form 
(RU-30). 

Rural General Public Transit form (RU-20)  

The Rural General Public Transit form (RU-20) collects key financial and non-financial operating information on each rural (§ 
5311) general public transit provider. Items include transit provider name and information, modal classification, service area, 
volunteer resources, number of vehicles and characteristics, number and ownership of maintenance facilities, annual 
operating expenses, operating revenues, annual capital costs, sources of capital funds, annual vehicle revenue miles, 
annual vehicle revenue hours, annual unlinked passenger trips, and safety information, as well as information on intercity 
bus and Indian Reservation services.  

Complete a separate RU-20 form for each rural provider of general public transit service within the State, Indian Tribe, or 
direct recipient. Report all available data for each provider, even if it is less than the data requested on the form. However, 
subrecipients must develop and implement procedures for complete data reporting in 2008. 

Statewide Summary form (RU-30)  

The Statewide Summary form (RU-30) summarizes the key financial and non-financial operating information for all rural 
transit services reported. The form automatically calculates the total for each data element reported for each rural transit 
service provider (State or Tribal subrecipients). Items include the number of vehicles, annual operating expenses, operating 
revenues expended, annual capital costs, sources of capital funds, and service data for annual revenue vehicle miles, 
annual revenue vehicle hours, annual unlinked passenger trips, asset/infrastructure information for vehicles and 
maintenance facilities, and safety information. 

Additionally, this form provides for the reporting of two statewide data items: 
1. The number of counties within the State 
2. The number of counties with transit service funded, in whole or in part, with FTA Other Than Urbanized Area Formula 

Program funds (§ 5311). 
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